# Table of Contents

**Introduction**  5

**Chapter 1: What's new?**  7
- Changed features in version 10.1.0  7
  - IBM Cognos Go! Search is renamed  7
  - IBM Cognos Go! Dashboard is renamed  7

**Chapter 2: Preparing to Install**  9
- Review the Release Notes Before You Install  9
- Review Supported Environments  9

**Chapter 3: Installing IBM Cognos for Microsoft Office**  11
- Installing Microsoft .NET Framework  11
- Uninstalling previous versions of IBM Cognos for Microsoft Office products  12
- Installing IBM Cognos for Microsoft Office  12
- Configuring IBM Cognos for Microsoft Office  14
  - Enabling anonymous access for PowerPlay  14
  - Installing the CA certificate for the HTTPS interface to Series 7 PowerPlay  14
  - Setting macro security level for Microsoft Office XP  15
- Enabling the Proper Display of Chinese Characters  15
  - Install GB18030 Support on a Microsoft Windows XP Client  15
  - Enable GB18030 Font Linking  16
- Testing IBM Cognos for Microsoft Office  16

**Chapter 4: Access permissions and credentials**  19
- Permissions for creating reports  20
- Permissions for viewing or refreshing contents of a package or a folder  20
- Permissions for accessing IBM Cognos Connection  21

**Appendix A: Rebranding IBM Cognos Office Components**  23
- Resource Files  23
- Rebranding or Localizing IBM Cognos Office Components  24
  - Edit the Resource (.resx) Files  25
  - Compile the Updated Resource Files  26
  - Test Your Work  26

**Appendix B: Setting Up an Unattended Installation**  27
- Set up the installation using a file generated from the Installation wizard  27
- Set up the installation using the response.ats file  29

**Appendix C: Troubleshooting**  31
- Troubleshooting Resources  31
  - Error Messages  31
  - Log Files  31
  - Windows Event Viewer  32
  - Samples  32
Introduction

This document is intended for use with IBM® Cognos® for Microsoft® Office. IBM Cognos for Microsoft Office is an add-in for retrieving content from IBM Cognos Business Intelligence reporting products, such as IBM Cognos Report Studio and PowerPlay Web, for use with Microsoft Office.

This application may be used by data modelers, business analysts, and financial analysts who analyze enterprise data to identify trends, opportunities, problems, or project characteristics.

Audience

This guide assumes that you are familiar with IBM Cognos products, such as IBM Cognos BI and PowerPlay. You should also be familiar with Microsoft Office systems, such as the Microsoft Excel spreadsheet software, Microsoft Word, and Microsoft PowerPoint presentation graphics program.

Finding information

To find IBM® Cognos® product documentation on the web, including all translated documentation, access one of the IBM Cognos Information Centers at http://publib.boulder.ibm.com/infocenter/cogic/v1r0m0/index.jsp. Updates to Release Notes are published directly to Information Centers.

You can also read PDF versions of the product release notes and installation guides directly from IBM Cognos product disks.

Accessibility features

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products. This product has accessibility features. For information on these features, see the accessibility section in this document.

Forward-looking statements

This documentation describes the current functionality of the product. References to items that are not currently available may be included. No implication of any future availability should be inferred. Any such references are not a commitment, promise, or legal obligation to deliver any material, code, or functionality. The development, release, and timing of features or functionality remain at the sole discretion of IBM.

Samples disclaimer

The Great Outdoors Company, GO Sales, any variation of the Great Outdoors name, and Planning Sample depict fictitious business operations with sample data used to develop sample applications for IBM and IBM customers. These fictitious records include sample data for sales transactions, product distribution, finance, and human resources. Any resemblance to actual names, addresses, contact numbers, or transaction values is coincidental. Other sample files may contain fictional data manually or machine generated, factual data compiled from academic or public sources, or data used with permission of the copyright holder, for use as sample data to develop sample appli-
Introduction

cations. Product names referenced may be the trademarks of their respective owners. Unauthorized duplication is prohibited.
Chapter 1: What's new?

This section contains a list of changed features for this release. It will help you plan your upgrade and application deployment strategies and the training requirements for your users.

To review an up-to-date list of environments supported by IBM® Cognos® products, including operating systems, patches, browsers, Web servers, directory servers, database servers, and application servers, visit the IBM Cognos Customer Center at www.ibm.com/software/data/support/customercenter.html

Changed features in version 10.1.0

Listed below are changes to features since the last release. Links to directly-related topics are included, if applicable.

IBM Cognos Go! Search is renamed

In earlier releases, enhanced search capabilities were available by installing IBM® Cognos® Go! Search with the IBM® Cognos® Business Intelligence server product. The enhanced search capability is now the default search mode in the IBM Cognos BI server product. Your IBM Cognos BI administrator does not have to install a separate package, but some configuration is required to set up index sharing for scalability and at least one index must be created before the enhanced search capability can be used.

IBM Cognos Go! Dashboard is renamed

In earlier releases of IBM Cognos BI, an interactive dashboard application was available by installing IBM Cognos Go! Dashboard with the IBM Cognos BI server product. In version 10.1.0, IBM Cognos Go! Dashboard is renamed as IBM Cognos Business Insight and is part of the IBM Cognos BI server product. Your IBM Cognos BI administrator does not have to install a separate package, but some tasks are required, including configuring access to the secured functions and features.
Chapter 1: What's new?
Chapter 2: Preparing to Install

Before you install the IBM® Cognos® Office components, you must set up resources in your environment so that the components can operate.

Use the following checklist to guide you through the setup process:

- Review the Release Notes.
- Review supported environments.

After you complete these tasks continue with "Installing IBM Cognos for Microsoft Office" (p. 11).

Review the Release Notes Before You Install

Before you install your IBM® Cognos® product, it is important to be aware of all issues that may affect your installation strategy.

There may be late-breaking issues that were not known when this installation guide was created.

Review the Release Notes before you install your product. The Release Notes contains late-breaking information about known issues, and documentation updates and deprecation notices. The Release Notes are available from the first page of the installation wizard or from the product disk. Release Notes updates are also available on the IBM Cognos Customer Center (www.ibm.com/software/data/cognos/customercenter/).

Review Supported Environments

To ensure that your product works properly, apply all minimum required operating system patches and use only the versions of other software that are supported for an IBM® Cognos® product.

To review an up-to-date list of environments supported by IBM Cognos products, such as operating systems, patches, browsers, Web servers, directory servers, database servers, and application servers, visit the IBM Cognos Customer Center (www.ibm.com/software/data/cognos/customercenter/).

It is important to note that the Linux® operating system is available in a number of distributions and supports a number of hardware platforms. Ensure that the combination of the operating system and hardware that you are using is supported.
Chapter 2: Preparing to Install
Chapter 3: Installing IBM Cognos for Microsoft Office

To use IBM® Cognos® for Microsoft® Office, you must install Microsoft .NET Framework 2.0 or later and the IBM Cognos for Microsoft Office components.

The IBM Cognos Business Intelligence samples include samples for IBM Cognos for Microsoft Office. The samples illustrate product features and technical and business best practices using data from a fictitious company, Great Outdoors. You can also use them for experimenting with and sharing report design techniques, and for troubleshooting. To use the samples, you must have your administrator set up and configure them or contact your administrator to find out where they are installed. For instructions on how to set up and configure samples, see the IBM Cognos Business Intelligence Installation and Configuration Guide or the IBM Cognos Administration and Security Guide.

You must first uninstall older components of IBM Cognos for Microsoft Office products before you can install the new components.

Use the following checklist to guide you in the installation process:

- Installing Microsoft .NET Framework.
- Uninstalling the previous version of IBM Cognos for Microsoft Office products, if required.
- Installing IBM Cognos for Microsoft Office components.
- Configuring IBM Cognos for Microsoft Office.
- Testing IBM Cognos for Microsoft Office.

Installing Microsoft .NET Framework

IBM® Cognos® for Microsoft® Office requires Microsoft .NET Framework version 2.0 or later to be installed on all user computers.

For a list of supported versions of Microsoft .NET Framework, see the IBM Cognos Customer Center at (www.ibm.com/software/data/cognos/customercenter).

When you install Microsoft .NET Framework on a non-English operating system, Microsoft .NET error messages, shortcuts, and utilities appear in English.

For a language other than English, you can apply the Microsoft .NET Framework Language Pack to view error messages, shortcuts, and utilities in the language of your operating system. For example, if your operating system is French and you installed Microsoft .NET Framework, you must also apply Microsoft .NET French Language Pack.

Steps

1. Go to the Microsoft download Web site.
2. Search for .NET Framework 2.0 or later, select the redistributable package, and follow the instructions to download it.

3. Check for other security updates that relate to your version of .NET Framework and download them.

Uninstalling previous versions of IBM Cognos for Microsoft Office products

If you have a previous version of IBM® Cognos® for Microsoft® Office or other IBM Cognos for Microsoft Office products, you must uninstall all previous versions before you can install the new version of IBM Cognos for Microsoft Office.

The uninstall does not completely remove all application files or directories during the uninstall process; therefore, you may have to perform this action manually.

If you installed more than one component in the same location, you can choose the packages to uninstall using the uninstall wizard. All components of the package will be uninstalled.

Before uninstalling, close all Microsoft® Office applications.

Steps

1. From the Start menu, click Programs, IBM Cognos for Microsoft Office, Uninstall IBM Cognos, Uninstall IBM Cognos.

   The Uninstall wizard appears.

   Tip: IBM Cognos for Microsoft Office is the default name of the Program Folder that is created during the installation. If you chose another name, go to that folder to find the program.

2. Follow the instructions to uninstall the component.

   The cognos_uninst_log.txt file records the activities that the Uninstall wizard performs while uninstalling files.

   Tip: To find the log file, look in the Temp directory.

Installing IBM Cognos for Microsoft Office

To install IBM® Cognos® for Microsoft® Office, you run an issetup.exe file from the appropriate directory on the product CD or central LAN location. The file installs a security update for Microsoft .NET Framework and then installs the IBM Cognos for Microsoft Office components.

To deploy IBM Cognos for Microsoft Office with PowerPlay, you can configure gateway mappings so that IBM Cognos for Microsoft Office users can access PowerPlay reports that reside on a PowerPlay server. You can also configure the size of report that can be imported from IBM Cognos BI to IBM Cognos for Microsoft Office. For more information about gateway mappings and report size limits, see the IBM Cognos Administration and Security Guide.
Application samples for IBM Cognos for Microsoft Office are on a separate disk. If you want to use the samples, your IBM Cognos BI administrator must install them from the IBM Cognos Business Intelligence Samples disk.

IBM Cognos for Microsoft Office is available as a 32-bit installation only. It must be installed on a 32-bit Windows® computer.

Before you update and install components, ensure that you

- have administrative privileges on the computer
- installed Microsoft .NET Framework 2.0 or later
- uninstalled any previous version of IBM Cognos for Microsoft Office
- have the appropriate license to use your IBM Cognos for Microsoft Office product

Steps

1. Insert the IBM Cognos for Microsoft Office CD or go to the location where the installation files were downloaded.
   
   The Welcome page of the installation wizard appears when you insert the CD.

2. If no Welcome page appears or you are not installing from the CD, go to the win32 directory, and double-click issetup.exe.

3. Select the language to use for the installation
   
   The language that you select determines the language of the user interface. You can change the language to any of the installed languages after installation.

4. In the License Agreement page, select I Agree and then click Next.

5. Repeat step 4 for the non-IBM license agreement.

6. In the Installation Location page, select the installation directory, such as C:\Program Files\Cognos\IBM Cognos for Microsoft Office\, and then click Next.
   
   If a dialog box appears, advising you to uninstall a previous version of IBM Cognos Office product, follow the prompts and uninstall the previous version, and then resume the installation.

7. In the Component Selection page, select IBM Cognos for Microsoft Office, and then click Next.

8. Follow the directions in the installation wizard to copy the required files to your computer.

9. In the Finish page of the installation wizard, if you want to see late-breaking information about IBM Cognos components, click View IBM Cognos Release Notes.

10. Click Finish.

If you want to use the samples that are available for IBM Cognos for Microsoft Office or IBM Cognos BI, your administrator must install the IBM Cognos BI samples. For more information, see the IBM Cognos Business Intelligence Installation and Configuration Guide.
Configuring IBM Cognos for Microsoft Office

After installing IBM® Cognos® for Microsoft® Office, you can configure settings so that users can access PowerPlay reports that reside on a PowerPlay server or change the macro security for Microsoft Office XP.

Use the following checklist to configure settings for IBM Cognos for Microsoft Office:

- Enabling anonymous access for PowerPlay
- Installing the CA certificate for the HTTPS Interface to Series 7 PowerPlay
- Setting macro security level for Microsoft Office XP

Enabling anonymous access for PowerPlay

When using single signon with Microsoft Internet Information Services (IIS), anonymous access must be enabled for users to access IBM Cognos for Microsoft Office documents that are based on PowerPlay reports. If necessary, a second PowerPlay gateway can be used to provide anonymous access for IBM Cognos for Microsoft Office. For more information, see the topic about specifying gateway mappings in the IBM Cognos Administration and Security Guide.

The administrator must follow these steps to enable Anonymous Access in IIS.

**Steps**

1. On each computer where Content Manager is installed, start IBM Cognos Configuration.

2. In the Explorer window, under Security, Authentication, click Cognos.

3. In the Properties window, click the box next to the Allow anonymous access property and then click True.

4. From the File menu, click Save.

Installing the CA certificate for the HTTPS interface to Series 7 PowerPlay

If your environment includes IBM® Cognos® Series 7 PowerPlay® Enterprise Server and you are using the HTTPS (https://) interface to access Series 7 PowerPlay, you must install a certificate issued by a certificate authority (CA). The CA certificate is required for secure sockets layer (SSL) support.

**Steps**

1. Retrieve the CA certificate from your administrator.

   The file has a .cer extension.

2. Double-click the .cer file, click Install Certificate, and then click Next.

3. Click Place all certificates in the following store.

4. Click Browse, click Trusted Root Certification Authorities, and then click Next.

5. Click Finish.
Setting macro security level for Microsoft Office XP

For Microsoft® Office XP applications to run IBM® Cognos® for Microsoft® Office, you must set your macro security level to an appropriate level. You must set this for Microsoft Office Excel, Microsoft Office Word, and Microsoft Office PowerPoint.

Steps
1. Open your Microsoft Office XP application.
2. From the Tools menu, click Macros, and then click Security.
3. Choose whether to change the security level or the trusted publishers.
   - On the Security Level tab, click Medium or Low, and then click OK
   - On the Trusted Publishers tab, select Trust all installed add-ins or templates, and then click OK.

Enabling the Proper Display of Chinese Characters

Simplified Chinese characters may not display properly in the IBM Cognos Office applications. To properly display Simplified Chinese characters, you must perform the following tasks:

- "Install GB18030 Support on a Microsoft Windows XP Client" (p. 15)
- "Enable GB18030 Font Linking" (p. 16)

Install GB18030 Support on a Microsoft Windows XP Client

If your locale is Simplified Chinese, ensure that the appropriate language support is installed so that the IBM Cognos for Microsoft Office applications can display the menus and dialog boxes correctly.

GB18030 is a Chinese National Standard for encoding characters. To display Simplified Chinese characters properly on Windows® XP or earlier, you must add GB18030 support for Windows core fonts, such as Tahoma, Arial, and Microsoft Sans Serif. The GB18030 Support Package contains SimSun18030.ttc, a TrueType font collection file that combines two Chinese fonts, SimSun-18030 and NSimSun-18030.

You can install the language support for Simplified Chinese on any non-Simplified Chinese version of Windows. Perform the following procedure on a computer with Windows XP installed.

Steps to Install GB18030 Support
1. From the Start menu, click Control Panel, and then double-click Regional and Language Options.
2. On the Languages tab, select the Install files for East Asian languages check box.
3. Install the GB18030 support package as a download from Microsoft.
Enable GB18030 Font Linking

To properly display GB18030 characters in IBM Cognos for Microsoft Office applications, ensure that:

- the language for non-Unicode programs is set to China - PRC in the Regional Settings and Language Options dialog box (Control Panel, Regional Settings and Language Options, Advanced tab)
- the FontLink registry entry contains SimSun-18030 in each active system font face name

Font linking allows you to render non-Latin characters when the font set by the application does not support those characters. It is used when an application cannot use a single font to render all the characters required. You can link one or more fonts, called linked fonts, to another font, called the base font.

After you link fonts, you can use the base font to display characters that do not exist in the base font, but that do exist in one of the linked fonts. For example, linking a Han font to a Tahoma font allows you to display the Chinese characters in a Tahoma font.

Important: Incorrectly editing the registry can cause serious problems that may require you to reinstall your operating system. You may not be able to resolve problems resulting from editing the registry. Before editing the registry, back up any valued data on the computer.

Steps
1. From the Windows Start menu, click Run.
2. In the Open box, type Regedit, and then click OK.
3. In the Registry Editor, go to the Registry branch:
   HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\FontLink\SystemLink
4. In the right pane, under Name, right-click the Tahoma font that you want to link to, and then click Modify.
5. In the Edit Multi-String dialog box, on a new line, add the following:
   SimSun18030.ttc,SimSun-18030
6. Click OK.
7. Repeat steps 4 to 6 for the Microsoft Sans Serif, Arial, and SimSun fonts that reference SimSun.
8. Click OK to restart the computer.

Testing IBM Cognos for Microsoft Office

You can test the installation of the client components by starting the application. IBM® Cognos® for Microsoft® Office starts automatically when users start Microsoft Excel, Microsoft Word, Microsoft PowerPoint, or when users open a Microsoft Office workbook, document, or presentation. Users can then link to IBM Cognos for Microsoft Office.
For full access to IBM Cognos for Microsoft Office, you should be a member of the Express Authors or Report Administrators role in IBM Cognos BI. An administrator must configure these privileges using IBM Cognos Administration.

**Steps**

1. Start Microsoft Excel, Word, or PowerPoint or open a Microsoft Office workbook, document, or presentation.

2. Confirm that **IBM Cognos** appears in the toolbar.
   
   If **IBM Cognos** is not in the toolbar, from the View menu, click Toolbars, IBM Cognos for Office.

3. To show the action pane, click **IBM Cognos** in the toolbar.
   
   The Welcome pane appears on the right side of the window. It includes a link to IBM Cognos for Microsoft Office.

4. Click **IBM Cognos for Microsoft Office** in the action pane.
   
   The heading of the action pane changes to **IBM Cognos for Microsoft Office**. You can switch between action panes by clicking the icons at the bottom of the action pane.
When a content store is initialized, the IBM® Cognos® Business Intelligence administrator sets the access permissions for your organization’s data. He or she specifies which users and groups have access to a specific report or other content in IBM Cognos software. The administrator also specifies the actions users can perform on the content. These permissions can be modified at any time to accommodate changes within the organization.

For full access to IBM® Cognos® for Microsoft® Office, you should be a member of the Express Authors or Report Administrators role in IBM Cognos BI. The administrator must configure these privileges using IBM Cognos Administration.

For more information about setting access permissions, see the IBM Cognos Administration and Security Guide.

For users of IBM Cognos for Microsoft Office, specific permissions must be granted for the following types of activities:

- retrieving data from the content store to create reports and viewing reports in IBM Cognos Viewer (p. 20)
- refreshing data or folders, and viewing contents of packages or folders (p. 20)
- downloading Microsoft Office documents from and publishing Microsoft Office documents to IBM Cognos Connection (p. 21)

Access permissions for users

At minimum, users must have traverse and read permissions for the parent entries of the entries in IBM Cognos Connection that they want to access. The parent entries include container objects such as folders, packages, groups, roles, and namespaces.

Note: If the administrator has granted users or the group to which users belong execute and traverse permissions on the package, they can run reports from a package, but not open the package in an IBM Cognos studio.

Accessing entries in IBM Cognos Connection associated with data sources secured against multiple namespaces

Data sources in IBM Cognos software can be secured against multiple namespaces. In some environments, the namespace used to secure the data source is not the primary namespace used for access to IBM Cognos Connection. When users try to access an entry, such as a report, a query, or an analysis, that is associated with a data source secured against multiple namespaces, and they are not logged on to all of the required namespaces, a prompt for authentication appears. Users must log on to the namespace before they can access the entry.

When single signon (SSO) is enabled, the prompt for authentication does not appear. Users are automatically logged on to the namespace.

This functionality applies to IBM Cognos Viewer only.
Permissions for creating reports

The following access permissions are required for retrieving data from the content store.

<table>
<thead>
<tr>
<th>Goal</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>View a report specification or a report output version, including reports in the result set of a search.</td>
<td>Read</td>
</tr>
<tr>
<td>Users must also have traverse permissions for the folder or package that contains the report.</td>
<td></td>
</tr>
<tr>
<td>Run a report or run a specified saved report output version.</td>
<td>Execute</td>
</tr>
<tr>
<td>For data sources, connections, and signons, retrieve data from a data provider. Users cannot read the database information directly. The report server can access the database information on their behalf to process a request.</td>
<td></td>
</tr>
<tr>
<td>Import report content from the content store</td>
<td>Execute</td>
</tr>
</tbody>
</table>

Permissions for viewing or refreshing contents of a package or a folder

The following access permissions are required to refresh data from the content store or view or search contents of a package or a folder.

<table>
<thead>
<tr>
<th>Goal</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>View the contents of a package or a folder, without full access to the content of the folder.</td>
<td>Traverse</td>
</tr>
<tr>
<td>To download Microsoft Office documents that were published to IBM Cognos Connection, users must also have Read permissions.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> Users can view the general properties of the entries in IBM Cognos Connection for which they have any type of access. The general properties include name, description, creation date, and so on, which are common to all entries.</td>
<td></td>
</tr>
<tr>
<td>Refresh the Public Folders and My Folders in the IBM Cognos BI pane that contain any reports or analyses that were cached.</td>
<td>Read</td>
</tr>
<tr>
<td>Perform full-text searches of content published to IBM Cognos BI.</td>
<td></td>
</tr>
</tbody>
</table>
Permissions for accessing IBM Cognos Connection

The following access permissions are required to download reports from or to publish Microsoft Office documents to IBM Cognos Connection.

<table>
<thead>
<tr>
<th>Goal</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open reports from IBM Cognos Connection from a Microsoft Office application and save the reports locally.</td>
<td>Read</td>
</tr>
<tr>
<td>Publish a Microsoft Office document to IBM Cognos Connection</td>
<td>Execute</td>
</tr>
<tr>
<td>Download reports from IBM Cognos Connection</td>
<td>Read and Traverse</td>
</tr>
</tbody>
</table>
Appendix A: Rebranding IBM Cognos Office Components

This section is intended for clients and partners who need to rebrand, customize, or localize labels, messages, or other strings in IBM Cognos Office products, such as IBM Cognos Analysis for Microsoft Excel®, IBM Cognos Office, and IBM® Cognos® for Microsoft® Office versions 8.4 and later.

Resource Files

All the customizable strings for IBM® Cognos® Office products are located in XML-based resource (.resx) files.

The .resx resource file format consists of XML entries that specify objects and strings inside XML tags. One advantage of a .resx file is that when opened with a text editor (such as Notepad or Microsoft Word) it can be written to, parsed, and manipulated. When viewing a .resx file, you can see the binary form of an embedded object, such as a picture when this binary information is a part of the resource manifest. Apart from this binary information, a .resx file is completely readable and maintainable.

A .resx file contains a standard set of header information that describes the format of the resource entries, and specifies the versioning information for the XML that parses the data.

These files contain all the strings, labels, captions, and titles for all text in the three IBM Cognos Office components. For each language, there are three files, one for each component. The following table identifies each of the files.

<table>
<thead>
<tr>
<th>Language</th>
<th>IBM Cognos Analysis for Microsoft Excel files (internal name cor)</th>
<th>IBM Cognos for Microsoft Office files (internal name coc)</th>
<th>IBM Cognos Office files (internal name coi)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language Neutral</td>
<td>cormsgs.resx</td>
<td>cocmsgs.resx</td>
<td>coimsgs.resx</td>
</tr>
<tr>
<td>Chinese (simplified)</td>
<td>cormsgs.zh-cn.resx</td>
<td>cocmsgs.zh-cn.resx</td>
<td>coimsgs.zh-cn.resx</td>
</tr>
<tr>
<td>Chinese (traditional)</td>
<td>cormsgs.zh-tw.resx</td>
<td>cocmsgs.zh-tw.resx</td>
<td>coimsgs.zh-tw.resx</td>
</tr>
<tr>
<td>Czech</td>
<td>cormsgs.cs.resx</td>
<td>cocmsgs.cs.resx</td>
<td>coimsgs.cs.resx</td>
</tr>
<tr>
<td>Dutch</td>
<td>cormsgs.nl.resx</td>
<td>cocmsgs.nl.resx</td>
<td>coimsgs.nl.resx</td>
</tr>
<tr>
<td>English</td>
<td>cormsgs.en.resx</td>
<td>cocmsgs.en.resx</td>
<td>coimsgs.en.resx</td>
</tr>
<tr>
<td>Finnish</td>
<td>cormsgs.fi.resx</td>
<td>cocmsgs.fi.resx</td>
<td>coimsgs.fi.resx</td>
</tr>
</tbody>
</table>
Rebranding or Localizing IBM Cognos Office Components

If you are setting the IBM® Cognos® component for a multilanguage environment, you must compile both the language-neutral file and the language file for your locale. The program detects the user locale settings in Windows and uses the appropriate language file. For example, suppose you installed IBM Cognos Analysis for Microsoft® Excel and your locale is set to French (France). You must make changes to the language-neutral files: cormsgs.resx and coimsgs.resx, and to the French files: cormsgs.fr.resx and coimsgs.fr.resx.

To customize or localize the component names and text messages, follow these steps:

- Edit the language-neutral resource files, and if necessary, the language resource files for your locale (p. 25).
- Download and then run the Resource File Generator (Resgen.exe) required for compiling the updated resource files (p. 26).
Edit the Resource (.resx) Files

For each component, there exists a set of files that support the various languages. The country code distinguishes the filenames. With the exception of the language-neutral set of files (cormsgs.resx, cocmsgs.resx, and coimsgs.resx) that serve as the default files, each file follows the following naming convention:

```
componentcodemsgs.languagecode.resx
```

You can change strings, not icon or graphic resources.

When changing text strings, consider the string length. The width of fields were created using the existing strings. Significantly increasing string length may result in some strings getting truncated in some of the dialog boxes.

The resource file contains metadata and comments that can help you determine when and where strings are used in the software.

**Important:** To edit XML resource files, use an XML editor. It is important to preserve the Unicode encoding and format, including white space. Simple text editors will likely corrupt the files. A validating XML editor ensures that the contents of the files are well formed and valid. Modify only string information. Do not change other information in the files.

**Steps**

1. Install the IBM Cognos Office components locally to a workstation.
   
   This gives you access to the resource files.

2. Locate the resource files.
   
   If you install locally and accept all the defaults, they are found in the following location:

   `installation directory\Program Files\Cognos\Cognos for Microsoft Office\resources`

3. In an XML Editor, open the `componentcodemsgs.languagecode.resx` file.
   
   Use an editor such as Visual Studio or XMLSpy to change the branding details or to translate strings into another language.

   If you are creating new language files, follow the naming convention by inserting the 2 or 5-character language code into the middle of the file name. For example, if you add a Romanian language file for IBM Cognos for Microsoft Office, you would save it as cocmsgs.ro.resx.

4. Save the file.

5. Repeat steps 3 and 4 for each component file associated with the language that you want to translate.

   The updated resource files are now ready to be compiled.
Compile the Updated Resource Files

Before you can deploy updated files, you must download the Resource File Generator (Resgen.exe). The Resource File Generator converts .txt files and .resx (XML-based resource format) files to common language runtime binary .resources files that you can embed in a runtime binary executable or compile into satellite assemblies.

The Resource File Generator is a Microsoft ® .NET Framework Software Development Kit (SDK) program that generates compiled resource files. The resgen executable is shipped with the Microsoft .NET SDK and comes with Microsoft Visual Studio development system. You must choose a version of the Resource File Generator that is compatible with the version of .NET Framework that is used by IBM Cognos Office components.

Resgen.exe performs the following conversions:

- Converts .txt files to .resources or .resx files.
- Converts .resources files to text or .resx files.
- Converts .resx files to text or .resources files.

Steps

1. Download the resgen.exe from the Microsoft .NET developer Web site.
2. After downloading the Resource File Generator, open a command prompt window.
3. Find the location where Resgen was downloaded.
   For example, cd C:\Program Files\Microsoft Visual Studio 8\v2.0\Bin
4. To compile the resource files, from the command prompt, type
   Resgen /compile "C:\resx file location\file name.resx"
   For example, resgen /compile "c:\ProgramFiles\Cognos\Cafe\resources\cormsgs.resx"
   Resource files are automatically renamed to include the .resource extension in their file name.
5. Copy the resulting files to the \Resources files directory.

Test Your Work

To test your work, run IBM Cognos Office using a variety of locales and start each component (IBM Cognos Office, IBM Cognos for Microsoft Office, and IBM Cognos Analysis for Microsoft Excel®) to ensure that your changes are reflected in each area.

Check the text changes in all the interfaces exposed to your users. Pay particular attention to generic dialog boxes, which are easy to miss.
Appendix B: Setting Up an Unattended Installation

Set up an unattended installation and configuration when you want to

- install an identical configuration across several computers on your network
- automate the installation process by specifying options and settings for users

There are two ways to set up an unattended installation. Both methods use a transfer specification file (.ats) to copy IBM® Cognos® for Microsoft® Office components to your computer without being prompted for information.

One method allows you to run the installation wizard on your computer. The selections that you make are recorded in a transfer specification file (.ats). You can use the generated .ats file to perform an unattended installation across other computers on your network. Alternatively, you can use the default response.ats file to automate the installation. The installer uses the values in the response file rather than requiring you to interact with it.

Before you set up an unattended installation and configuration, ensure that all the system requirements and prerequisites are met and that all third-party products are installed and configured.

For more information, see "Installing IBM Cognos for Microsoft Office" (p. 11).

To set up an unattended installation and configuration:

- configure a transfer specification file (.ats) to specify installation options
- run the installation tool in silent mode

Set up the installation using a file generated from the Installation wizard

By default, each time you install IBM® Cognos® for Microsoft® Office components using the installation wizard, the options that you select are recorded in a transfer specification file. Therefore, if you already installed IBM Cognos for Microsoft Office components on a development computer, you can use the generated transfer specification file as a template for unattended installations on different computers. You can do this by starting the installer from the command line and passing the response file in as an argument.

You can check if the unattended installation was successful by checking the return status. A value of zero (0) indicates success and all other values indicate that an error occurred.

Steps

1. Use the installation wizard to install the IBM Cognos for Microsoft Office component, such as IBM® Cognos® Analysis for Microsoft Excel or IBM® Cognos® for Microsoft® Office, on your computer.

2. Go to c10Office_location/instlog.
3. Locate the transfer specification file (.ats) that was generated:
   - If you installed IBM Cognos for Microsoft Office, the file name is ts-COC-version-yyyymmdd _hhmm.ats.
   - If you installed IBM Cognos Analysis for Microsoft Excel, the file name is ts-COR-version-yyyymmdd _hhmm.ats.

4. Copy the transfer specification file to the computer where you plan to install the IBM Cognos for Microsoft Office component.

5. On the computer where you plan to install the software, insert the appropriate CD and copy the contents of the CD to your computer.

6. In a text editor, open the transfer specification file (.ats) that you copied.

7. In the section named License Agreement, change the I AGREE= property to y.
   This action means that you are accepting the license agreement. To read the terms of the license agreement, see the LA_language_code and notices files in either of these locations:
   - on the product disk - in the root installation directory for the operating system
   - on the computer from which you copied the response.ats file - in the c10_location\license\product directory

8. Save the transfer specification file in the directory where you copied the contents of the installation CD, and in the same folder that contains the installer executable file, issetup.exe.

9. Open a Command Prompt window, and then change to the directory in which the installer, issetup.exe, is located.

10. Type the following command, where location is the file path location of the transfer specification file:

    issetup -s location\filename.ats

    The progress of the installation appears in the Windows® taskbar.

    If zero (0) is not returned, check the log files for error messages. Errors are recorded in the installation directory in the following log file:

    - For IBM Cognos for Microsoft Office, the file name is tl-COC-version-yyyymmdd-hhmm_summary-error.txt.
    - For IBM Cognos Analysis for Microsoft Excel, the file name is tl-COR-version-yyyymmdd-hhmm_summary-error.txt.

    If errors occur before sufficient initialization occurs, log messages are sent to one of the following log files in the Temp directory:

    - For IBM Cognos for Microsoft Office, the file name is tl-COC-version-yyyymmdd-hhmm.txt.
    - For IBM Cognos Analysis for Microsoft Excel, the file name is tl-COR-version-yyyymmdd-hhmm.txt.
Set up the installation using the response.ats file

If you do not use the installation wizard to install components, you can use the default transfer specification file named response.ats that is available on the CD. Use the response.ats file to copy IBM® Cognos® for Microsoft® Office components to several computers without being prompted for information.

You must modify the response.ats file for your environment before you can use it for an unattended installation.

You can check if the unattended installation was successful by checking the return status. A value of zero (0) indicates success and all other values indicate that an error occurred.

Steps

1. On the target computer, insert the CD and copy the contents to the computer.

2. In a text editor, go to the operating system directory in the file structure that you copied and open the response.ats file.
   
   Each section in the response.ats file corresponds to a dialog box in the installation wizard.

3. In the section named License Agreement, change the I AGREE= property to y.
   
   This action means that you are accepting the license agreement. To read the terms of the license agreement, see the LA_language_code and notices files in the root installation directory for the operating system on the product disk.

4. In the APPDIR=location, type the installation location of the program files for the IBM Cognos for Microsoft Office component.
   
   Tip: Ensure that there are no spaces on either side of the equal sign (=).

5. For the APPFOLDER= property, type the name of the Start menu folder that contains your program shortcuts.
   
   Tip: To ensure that the shortcut folder is visible to all users, for the ALLUSERS_FLAG= property, type 1.

6. In the section named [Component List], next to each component:
   
   • To install the component, type 1.
   
   • To not install the component, type 0.
   
   For example, COR_APP=0 or COC_APP=0.

7. In the [Install Conditions] section:
   
   • To specify that the condition is true, type 1.
   
   • To specify that the condition is false, type 0.

8. After you make the necessary changes, save the response.ats file to a local directory.

9. Open a Command Prompt window, and then change to the directory in which the installer, issetup.exe, is located.
10. Type the following command, where location is the file path location of the transfer specification file:

```
isssetup -s location/response.ats
```

The progress of the installation appears in the Windows® taskbar.

If zero (0) is not returned, check the log files for error messages. Errors are recorded in the installation directory in the following log file:

- For IBM Cognos for Microsoft office, the file name is tl-COC-version-yyyyymmdd-hhmm_summary-error.txt.
- For IBM Cognos Analysis for Microsoft Excel, the file name is tl-COR-version-yyyyymmdd-hhmm_summary-error.txt.

11. If errors occur before sufficient initialization occurs, log messages are sent to one of the following log files in the Temp directory:

- For IBM Cognos for Microsoft Office, the file name is tl-COC-version-yyyyymmdd-hhmm.txt.
- For IBM Cognos Analysis for Microsoft Excel, the file name is tl-COR-version-yyyyymmdd-hhmm.txt.
Appendix C: Troubleshooting

Use this troubleshooting information as a resource to help you solve specific problems you may encounter during or after the installation of IBM® Cognos® for Microsoft® Office components.

Troubleshooting Resources

Troubleshooting resources are sources of information that can help you resolve a problem that you are having with a product.

Sources of troubleshooting information include logs, debugging modes, documentation, and technical support. In addition to this document, the following troubleshooting resources are available when you work with IBM® Cognos® for Microsoft® Office:

- error messages (p. 31)
- log files (p. 31)
- Windows Event Viewer (p. 32)
- samples (p. 32)
- Technotes knowledge base (p. 32)
- IBM Cognos Customer Center (p. 33)

Error Messages

The first indication of a problem is often an error message. Error messages contain information that can be helpful in determining the cause of a problem.

Log Files

Log files can help you troubleshoot problems by recording the activities that take place when you work with a product. Operations performed in IBM® Cognos® for Microsoft® Office are recorded in a log file for tracking purposes.

Before you begin viewing log files, ensure that they contain the information that you need. The number of log files and the information they contain are set by parameters that you control. In most cases, the log file is locked while the application is running. To email the log file, you must exit the application first.

When troubleshooting, the following files can assist you:

**IBM Cognos Server Log File**

This file contains information about the Report Data Service processes.
Appendix C: Troubleshooting

**IBM Cognos Office Log File**

This file, such as Log_090616_154555.txt contains information about IBM Cognos for Microsoft Office processes. You turn this log on or off and select the level of logging details by setting the Log Level box in the Options dialog box in IBM Cognos for Microsoft Office.

**Windows Event Viewer**

Windows® Event Viewer provides information about program, security, and system events. For example, if an IBM Cognos service fails to start, this fact is recorded in the event log.

Windows Event Viewer does not record information that is specific to operations or tasks performed in IBM Cognos for Microsoft Office. Consult the IBM Cognos for Microsoft Office log file for these problems.

For information about how to use Windows Event Viewer, see the Windows help.

**Samples**

IBM® Cognos® for Microsoft® Office uses samples to highlight product features and to help you learn how to use the product. You can also use samples to troubleshoot problems. You can use the samples that come with IBM Cognos for Microsoft Office to determine if various components are working together as expected. For example, if you are having a problem running a report, you can try running a sample report to see if the problem persists. You may discover that the problem is related to connecting to a database.

**Search the Technotes knowledge base**

Technotes is a database of documents maintained by IBM Cognos support personnel containing problems logged by customers. Consequently, a problem you are experiencing with IBM Cognos® for Microsoft® Office may already be reported by someone else, and a solution already found. If Technotes does not include the problem you are having, you can call IBM Cognos Customer Center for individual assistance.

You can search the Technotes from anywhere on ibm.com. The Web page that you are on is the product filter. That means you can search the Technotes knowledge base by doing one or more of the following:

- Search from the top masthead that appears on any IBM Web page.
  
  Note: This searches across all of IBM and is not recommended.

  
  This searches all IBM Cognos products.

- Search from a particular product page.
  
  This returns only the documents that are associated with that product.
Call Cognos Software Services

If you are unable to resolve a problem using all other troubleshooting resources, call IBM Cognos support to receive immediate help. For information about IBM Cognos support locations and programs, see the IBM Cognos Customer Center Web site at [www.ibm.com/software/data/cognos/customercenter/](http://www.ibm.com/software/data/cognos/customercenter/).

To contact IBM Cognos Customer Center, you must have a current support agreement with Cognos, an IBM Company.

Before you call, do the following:

- Ensure that the problem is related to IBM Cognos software and results in an IBM Cognos error message.
- Attempt to reproduce the problem to ensure that it is not just a simple error.
- Check obvious things like file locations, directories, paths, and access.
- Review all relevant documentation, including any release notes or readme files.
- Check to see if any recent changes in your computing environment may be responsible for the problem.

Steps

1. Have the following information at hand:
   - your customer identification number
   - your case reference number, if it is an ongoing case
   - the phone number where you can be reached
   - the version of the software you use
   - the version of the operating environment you use
   - a description of what you were doing when the problem occurred
   - the exact wording of any error messages that appear
   - any steps you took to attempt to solve the problem

2. Contact the IBM Cognos support center nearest you.

3. You are asked whether this is a new or ongoing case. If it is an ongoing case, provide your case reference number or, if appropriate, your customer identification number.

If you don’t have support on the software about which you are calling, you will be directed to a support renewal representative.
Common Errors

This section lists the most-common errors that you might encounter with IBM® Cognos® for Microsoft® Office. For a complete listing, which includes numbered error messages and warnings for IBM Cognos Business Intelligence products, refer to the IBM Cognos Administration and Security Guide.

Configuration Issues

The following issues are related to configuration and setup.

The IBM Cognos Office Interface Fails to Initialize in Microsoft Office

IBM® Cognos® Office may not initialize when the Microsoft® .NET Framework is not installed or the version is not correct. The required Microsoft .NET Framework version is 2.0 or later. Another possible reason for this condition is that the IBM Cognos Office COM add-in is either not installed or not registered.

If you are running the wrong version of Microsoft .NET Framework, uninstall it and then reinstall Microsoft .NET Framework version 2.0 or later.

To install the IBM Cognos Office COM add-in, run the .msi program that is found on the installation CD. For more information, see the installation guide.

Before you attempt to install Microsoft .NET Programmability Support, you must have installed Microsoft .NET Framework version 2.0 or later.

IBM Cognos for Microsoft Office Does Not Start in Microsoft Word

You open an IBM Cognos for Microsoft Office session in Microsoft Word, but nothing appears to happen.

This can occur if Microsoft Outlook has opened a session of Microsoft Word to edit email messages. To check whether you are using Word to edit email messages, in Microsoft Outlook, click Tools, Options, Mail Format. In the Message format section of the dialog box, verify the options for editing your email messages.

To resolve this problem, close Microsoft Outlook before opening the Microsoft Word document configured for IBM Cognos for Microsoft Office.

IBM Cognos Office Fails to Initialize in Microsoft Internet Explorer

If you use Internet Explorer to browse IBM Cognos Business Intelligence and open a workbook, document, or presentation published by IBM Cognos Office, the document launches in Microsoft Office, but without full functionality.

To configure Internet Explorer to open Microsoft Office files in Microsoft Office instead of in Internet Explorer, you must use the Folder Options tool to update browse options. It is also possible to do this in Windows Registry.

Steps to Configure Internet Explorer to Open Microsoft Office Documents in Microsoft Office Applications

1. Open My Computer.
2. From the Tools menu, click Folder Options.

3. On the File Types tab, under Registered file types, click Microsoft Excel Worksheet, and then click Advanced.
   
   The Edit File Type dialog box appears.

4. Clear the Browse in same window check box and click OK.

5. Complete the same steps for Microsoft Office PowerPoint presentations and Microsoft Office Word documents.

**bo:heap Buffer Overflow Error**

After long sessions, Microsoft Office may stop responding by generating a bo:heap Buffer Overflow error.

This error may be falsely identified as a potential virus by some virus-monitoring programs.

**Microsoft Office Does Not Open a Microsoft Office Document Published from IBM Cognos Office**

If you observe Microsoft Office trying to open a published document twice when you double-click the workbook, document, or presentation from Windows Explorer, the file association is either corrupted or not installed properly.

There are two options to resolve this issue. You can start the Microsoft Office application first, and then open the document using the Open command from the File menu, or you can reregister the file type.

**Steps to Reregister Workbook File Types for Microsoft Office Excel**

1. From the Start menu, click Run.

2. Type the following command and click OK.

   "C:\Program Files\Microsoft Office\Office\Excel.Exe" /regserver

   You can adapt this command to your environment by providing the proper local drive and location.

**Steps to Reregister Presentation File Types for Microsoft Office PowerPoint**

1. From the Start menu, click Run.

2. Type the following command and click OK.

   "C:\Program Files\Microsoft Office\Office\Powerpnt.Exe" /regserver

   You can adapt this command to your environment by providing the proper local drive and location.

**Steps to Reregister Document File Types for Microsoft Office Word**

1. From the Start menu, click Run.

2. Type the following command and click OK.
Unable to Open Published Microsoft Office Documents from IBM Cognos Connection

If the browser does not prompt you to open or save the workbook, document, or presentation, it may mean that the option to prompt before opening was cleared. Reset this option.

You must enable the File Download and Automatic prompting for file downloads in Internet Explorer.

Steps to Confirm Opening of Documents
1. Start the Windows Control Panel.
2. Double-click Folder Options.
3. From the Folder Types tab, in the Registered file types list, click Microsoft Excel Worksheet, and then click Advanced.
4. Ensure that the Confirm open after download check box is selected and click OK.
5. Repeat steps 3 and 4 for other Microsoft Office documents that are supported in IBM Cognos Office, such as Microsoft Office Excel Template, Microsoft PowerPoint Presentation, Microsoft Office PowerPoint Template, Microsoft Word Document, and Microsoft Office Word Template.
6. Click Close.

Steps to Reset Internet Security Options
1. Start Internet Explorer.
2. From the Tools menu, click Internet Options.
3. From the Security tab, click the Web content zone for which you are updating these options, and then click Custom Level.
4. Scroll down to the Downloads section and click Enable for the File download and Automatic prompting for file downloads options.
5. Click OK twice.

Unable to import PowerPlay Studio reports
The request to import a PowerPlay Studio report fails.

When using single signon with Microsoft® Internet Information Services (IIS), anonymous access must be enabled for users to access IBM® Cognos® for Microsoft Office documents that are based on PowerPlay reports. If necessary, a second PowerPlay gateway can be used to provide anonymous access for IBM Cognos for Microsoft Office. For more information, see the topic about specifying gateway mappings in the IBM Cognos BI Administration and Security Guide.
The administrator must follow these steps to enable Anonymous Access in IIS.

**Steps**
1. On each computer where Content Manager is installed, start IBM Cognos Configuration.
2. In the **Explorer** window, under **Security, Authentication**, click **Cognos**.
3. In the **Properties** window, click the box next to the **Allow anonymous access** property and then click **True**.
4. From the **File** menu, click **Save**.

**Error Messages, the .NET shortcut, or the .NET Console Are Not in the Language of the .NET Framework 2.0 That Was Installed**

When you install a non-English version of .NET Framework in a non-English operating system, you will notice that the error messages, .NET shortcut and .NET Console are in English. To solve this issue, you must apply the .NET Framework Language Pack for your language. The subkey numbers relate to the language as follows: 1033=en-en, 1036=fr-fr, 1031=de-de, and 1041=ja.

If you are missing the language pack subkeys, you must install the .NET language pack, which is available from the Microsoft support Web site.

**Workbook Closes Unexpectedly**

If you install the COM add-in and your Microsoft Excel workbook name contains a square bracket, Excel stops responding or closes unexpectedly after opening.

To resolve this problem, rename the workbook so that it does not contain square brackets.

**The server committed a protocol violation**

The EXCEL.EXE.config file is required and is missing. Section=ResponseHeader Detail=CR must be followed by LF.

You must create the EXCEL.EXE.config file, copy it to the same location as IBM Cognos Analysis for Microsoft Excel® and add the following lines:

```xml
<?xml version="1.0" encoding="utf-8" ?>
<configuration>
  <system.net>
    <settings>
      <httpWebRequest useUnsafeHeaderParsing="true" />
    </settings>
  </system.net>
</configuration>
```
Appendix C: Troubleshooting

Reports Unavailable in IBM Cognos Connection Jobs after Using Save As Command in IBM Cognos Report Studio

After opening a report in IBM Cognos Report Studio and saving a copy using the Save As command, you may find that if the report is included in a job, it is not available in the IBM Cognos Connection portal.

Do not use the Save As command in IBM Cognos Report Studio to save changes when a report is included in a job. Instead, make a copy of the report, make changes to the copy, and then copy the updated report to the IBM Cognos Connection portal. Use this method to overwrite the report in the job without breaking the report links.

Unable to Correctly Display East Asian Characters

Your locale is set to one of the East Asian languages and odd characters or question marks appear in the user interface, dialog boxes, and menus.

IBM Cognos Office products support GB18030, which is a Chinese National Standard for encoding characters. To display Simplified Chinese characters properly on Windows XP or earlier, you must add GB18030 support for Windows core fonts and then enable font linking.

To resolve this issue, after installing the language support for Simplified Chinese, ensure that you have linked the SimSun18030.ttc font collection to the following core fonts:

- Tahoma
- Arial
- Microsoft Sans Serif
- SimSun

For more information, see the installation guide for the specific product.

The Content of the Cell-based Report Shows #NAME?

When building a cell-based report in IBM Cognos Analysis for Microsoft Excel®, the content of the cells shows #NAME?

When you drag items from the source tree directly to a cell of a worksheet, you are creating a COGNAME or COGVAL formula that references the item in the database. This functionality is available only when the CognosOfficeUDF.Connect automation add-in is loaded.

If #NAME? appears in the contents of the cell, it means that the add-in was not loaded and the CognosOfficeUDF.Connect check box in the Add-in dialog box (Tools, Add-Ins) is not selected.

To resolve this issue and ensure that the add-in is always properly loaded, you must verify that the value of the OPEN registry key is set to /A “CognosOfficeUDF.Connect”.

Steps

1. From the Windows Start menu, click Run.
2. In the Open box, type Regedit, and then click OK.
3. In the Registry Editor, go to the Registry branch:
HKEY_CURRENT_USER\SOFTWARE\Microsoft\Office\version\Excel\Options

4. In the right pane, under Name, right-click OPEN, and then click Modify.

5. In the Value Data box, type

   /A "CognosOfficeUDF.Connect"

6. Click OK, and then close the Registry Editor.
Appendix C: Troubleshooting
Appendix D: Accessibility features for the Installation Wizard

Accessibility features help users who have a disability, such as restricted mobility or limited vision, to use information technology products successfully.

Accessibility features

The Installation wizard has accessibility features that help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products successfully.

The following list includes the major accessibility features in the Installation wizard:

- You can use accelerators and command keys to navigate through the Installation wizard.
  
  In Microsoft® Windows®, press the Alt key, then the accelerator to trigger an action; for example, ALT+S indicates that you press and hold the ALT key and then press the S key.

- The Installation wizard uses Microsoft Active Accessibility (MSAA). This means that people with limited vision can use screen-reader software, along with a digital speech synthesizer, to listen to what is displayed on the screen.

Keyboard navigation in the Installation wizard

The following table lists the keyboard shortcuts that you can use to perform some of the main tasks in the Installation wizard on the Windows® operating system. If you are using a screen reader, you may want to maximize your window so the keyboard shortcut tables in the following topics are completely expanded and accessible.

Note: The following keyboard shortcuts are based on U.S. standard keyboards. Some of the content in this topic may not be applicable to some languages.

<table>
<thead>
<tr>
<th>Goal</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page.</td>
<td>TAB</td>
</tr>
<tr>
<td>Return to the previous field on a page.</td>
<td>SHIFT+TAB</td>
</tr>
<tr>
<td>Close the installation wizard.</td>
<td>ALT+F4</td>
</tr>
<tr>
<td>Move to the next configuration step.</td>
<td>ALT+N</td>
</tr>
<tr>
<td>Return to the previous configuration step.</td>
<td>ALT+B</td>
</tr>
<tr>
<td>Move to the next selection in a list.</td>
<td>DOWN ARROW</td>
</tr>
</tbody>
</table>
Appendix D: Accessibility features for the Installation Wizard

<table>
<thead>
<tr>
<th>Goal</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the previous selection in a list.</td>
<td>UP ARROW</td>
</tr>
<tr>
<td>Perform the action for the selected button, or select or clear the</td>
<td>SPACEBAR</td>
</tr>
<tr>
<td>selected check box.</td>
<td></td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts that you can use to perform some of the main tasks in the License Agreement pages of the Installation wizard.

<table>
<thead>
<tr>
<th>Goal</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept the license agreement.</td>
<td>ALT+A</td>
</tr>
<tr>
<td>Decline the license agreement.</td>
<td>ALT+D</td>
</tr>
<tr>
<td>Close the Installation wizard when the license agreement has been</td>
<td>ALT+X</td>
</tr>
<tr>
<td>declined.</td>
<td></td>
</tr>
</tbody>
</table>

**Vendor software**

The IBM® Cognos® for Microsoft® Office components include certain vendor software that is not covered under the IBM license agreement. IBM makes no representation about the accessibility features of these products. Contact the vendor for the accessibility information about its products.

**IBM and accessibility**

See the IBM Human Ability and Accessibility Center (www.ibm.com/able) for more information about the commitment that IBM has to accessibility.
Index

Symbols
.ats file, 27
.ats file type, 27
.exe file type, 27
.NET Framework
    troubleshooting, 37
    version, 34
.NET programmability support, 34
tcc, 16
#NAME? errors, 38

A
access
    requirements to install IBM Cognos for Microsoft Office, 12
    requirements to use IBM Cognos for Microsoft Office, 16
accessibility
    features in product, 41
    Installation wizard, 41
access permissions, 19
    users, 19
anonymous access, 36
    accessing PowerPlay, 14
authentication
    prompts, 19

B
bo\:heap Buffer Overflow
    troubleshooting, 35

C
CA certificate
    installing for Series 7 PowerPlay, 14
cell-based reports
    #NAME? errors, 38
client software
    installing, 12
Com Add-in
    Excel workbook closes unexpectedly, 37
configuration
    issues, 34
    credentials, 19

data sources
    securing against multiple namespaces, 19

east Asian characters, 38
enhanced search capabilities, 7
environments, 9
    supported, 9
error messages
    bo\:heap Buffer Overflow, 35
    Excel workbook closes unexpectedly, 37
    IBM Cognos Office fails to initialize in Microsoft Internet Explorer, 34
    IBM Cognos Office Fails to Initialize in Microsoft Office, 34
    Microsoft Office Excel does not open a workbook published from IBM Cognos Office, 35
    reports unavailable in IBM Cognos Connection jobs after using Save As command in IBM Cognos Report Studio, 38
    unable to open published Microsoft Office documents from IBM Cognos BI, 36

F
file types
    registering, 35
fonts
    linking or chaining, 16
    linking to core fonts, 38
    Simplified Chinese, 16

G
gateways, 14
GB18030
    Simplified Chinese language support, 15
Index

support, 38
go_office.msi file, 12

H
Han characters
troubleshooting, 38

I
IBM Cognos Analysis for Microsoft Excel
cell-based report errors, 38
IBM Cognos Business Insight, 7
IBM Cognos Connection
troubleshooting unavailable reports, 38
unable to open published Microsoft Office documents, 36
IBM Cognos for Microsoft Office
batch log files, 31
macro security level for Microsoft Office XP, 15
opening in Microsoft Word, 34
samples, 32
testing the installation of client components, 16
uninstalling, 12
IBM Cognos for Microsoft Office gateway
log files, 31
IBM Cognos for Microsoft Office report server
log files, 31
IBM Cognos Go! Dashboard, 7
IBM Cognos Go! Search, 7
IBM Cognos Office
configuration and setup issues, 34
failure to initialize in Microsoft Office, 34
troubleshooting opening published documents, 35
IBM Cognos support, 33
IIS (Internet Information Services)
using single signon, 36
IIS (Microsoft Internet Information Services), 14
installations
COM add-in, 34
unattended, 27
installation wizard, 12
Installation wizard
compatibility, 41
installer program, 27
installing
IBM Cognos for Microsoft Office, 11
Microsoft .NET Framework, 11
without user interaction, 27
Internet Explorer, 34
issetup.exe (installer), 27

J
Japanese characters
troubleshooting, 38

K
keyboard shortcuts, 41
Knowledge Base, 32
Korean characters
troubleshooting, 38

L
languages
installing GB18030 support package, 15
supporting Simplified Chinese, 15
troubleshooting pack subkeys, 37
linked fonts, 38
Linux
unsupported features and components, 9
locales
Simplified Chinese, 15
log files, 31
logging on
multiple namespaces, 19

M
Microsoft .NET Framework, 11
installing, 11
Microsoft Excel
#NAME? errors, 38
workbook closes unexpectedly, 37
Microsoft Internet Explorer
cannot initialize IBM Cognos Office, 34
setting security options, 36
Microsoft Internet Information Services (IIS), 14
Microsoft Office XP
setting macro security level, 15
Microsoft Outlook
resolving IBM Cognos for Microsoft Office issues, 34
Microsoft Word
IBM Cognos for Microsoft Office does not start, 34
N
namespaces
  multiple, 19
native language support, 38
navigation keys, 41
non-English operating system
  troubleshooting .NET Framework, 37
non-Unicode languages, 16

P
PIAs (Primary Interop Assemblies)
  installing subkeys, 34
Portal Services
  availability on Linux, 9
Powerplay
  enabling anonymous access, 14
PowerPlay
  installing CA certificate, 14
PowerPlay Studio, 36
Primary Interop Assemblies (PIAs), 34
privileges
  required to install IBM Cognos for Microsoft Office, 12
  required to use IBM Cognos for Microsoft Office, 16
published documents
  opening in Microsoft Office, 35
  unable to open from IBM Cognos Connection, 36

R
registry entries, 16
release notes, 9
  reviewing before you install, 9
reports
  cell-based with #NAME? errors, 38
  importing PowerPlay Studio, 36
Report Studio
  saving changes in a job, 38
requirements
  to install IBM Cognos for Microsoft Office, 12
  to use IBM Cognos for Microsoft Office, 16
response.ats, 27, 29
  reviewing the release notes before you install, 9

S
samples, 32
screen reader, 41
searches, 7
Series 7 PowerPlay
  installing CA certificate, 14
setup issues, 34
shortcut keys, 41
silent installation, 27
Simplified Chinese
  installing GB18030 language package, 15
  supported fonts, 16
  supporting the locale, 15
  troubleshooting, 38
SimSun18030.tcc, 16
single signon, 36
  using with IIS, 14
support, IBM Cognos, 33
supported environments, 9
system requirements, 9

T
testing
  installation of IBM Cognos for Microsoft Office, 16
transfer specification file (.ats), 27, 29
  troubleshooting, 31
  importing PowerPlay Studio reports, 36
  resources, 31
ttc file, 16

U
unattended installation, 27
uninstalling
  IBM Cognos for Microsoft Office, 12
users
  classes and permissions, 19

W
Windows Event Viewer, 32